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1 ORGANIZATION OF THE HW4 MANUALS

The HW4 manuals are organized in separate books so as to limit the size of the individual documents. A list
of the HW4 manuals is provided in document E-M-HW4v3-DIR

HW4 Manuals

Contents

HW4 Main Book

General software description

Installation, start-up and settings

Device connection methods

Functions common to all devices used with HW4

Device Specific Functions 1
(separate book for each device type or model)

Legacy devices (original HygroClip technology):

(o]

HygroLog NT data logger

HygroFlex 2, HygroFlex 3 and M3 transmitters
(same icon in device tree)

HygroLab 2 and HygroLab 3 bench indicators
HygroPalm 2 and HygroPalm 3 portable indicators
HygroClip DI digital interface

HygroClip Alarm programmable logic

HygroStat MB

(o]

O o0OO0OO0O0o

Device Manager (device configuration) and other device
specific functions

Probe Adjustment 1

Humidity and temperature adjustment function common to
all legacy devices (original HygroClip technology)

Device Specific Functions 2
(separate book for each device type or model)

Devices based on the AirChip 3000 technology:

HygroClip 2 (HC2) probes

HF3 transmitters and thermo-hygrostats
HF4 transmitters

HF5 transmitters

HF6 transmitters

HF7 transmitters

HF8 transmitters

HL20 and HL21 data loggers

HP21, HP22 and HP23 hand-held indicators
Custom designed OEM products

OO0OO0OO0OO0OO0OO0ODOOO

Device Manager (device configuration) and Data Logging
functions

Probe Adjustment 2

Humidity and temperature adjustment function common to
all devices based on the AirChip 3000 technology

Data Recording

Data recording function common to all devices based on the
AirChip 3000 technology

Both the HW4 manuals (software) and device specific manuals (hardware) are available from the HW4 CD.
The manuals can also be downloaded from several of the ROTRONIC web sites.
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2 OVERVIEW
This section of the HW4 manual covers only the following HW4 module:
HWA4 Functional Modules for the HP23 | Usage
Device Manager o0 HP23 user configurable settings and functions
Record Data o Data capture and Data logging by the HP23

o HW4 functions that are not device dependent are covered in the HW4 manual E-IN-HW4v3-Main.

2.1 Functions and settings overview

By itself, the HC2 probe (HygroClip 2) used with the HP23 indicator is already a full-fledged measuring
instrument that can be used as a stand-alone device. The role of the HP23 indicator is to provide power to
the HC2 probe and to offer additional functionality and features such as: local data display, local keypad for
accessing most settings and functions, calculation of additional psychrometric parameters, manual data
capture, automatic data recording, water activity measurement and probe adjustment.

It is important to note that when used together, the HP23 indicator and HC2 probe (HygroClip 2) constitute a
2-component system. Each system component has its own microprocessor, firmware and functions. Some
of these functions are unique to each system component. Other functions are found in both components.

The functions and settings of the HP23 indicator and HygroClip 2 probe (HC2) operate together as indicated
below:

Function / Setting HP23 | HC2 | Notes

Device protection X X Individual to the HP23 and HC2 probe
RS-485 address X X Individual to the HP23 and HC2 probe
User defined description
Device Name X X The device name of the HC2 probe is not displayed by HW4 and is

replaced with the HP23 Input Name

Psychrometric calculation

Calculation X X | HpP23 setting overrides HC2 probe setting

Fixed pressure

value X Barometric pressure used for some psychrometric calculations

Refresh interval for the LC display. When set above 1 s, this setting
causes the HC2 probe not to be powered in between display

Data refresh rate X refreshes so as to conserve battery power.

Note: when the HP23 is recording data, the probe is powered as
required by the log interval, regardless of the display refresh interval.

Generates fixed humidity and / or temperature value

Simulator function X X When enabled, HP23 settings override the HC2 probe settings

HP23 setting overrides HC2 setting regarding the HP23

Unit system X X HC2 probe settings still apply at the level of the probe
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Function / Setting HP23 | HC2 | Notes
HP23 settings are independent from the HC2 probe settings.
g::}gf—“m'ts value X X The HP23 does not monitor out-of-limit values defined at the level of
the probe. Out-of-limit values should be defined at the level of the
HP23..
Analog outputs X Parameter and scale
HC2 probe settings have no effect on the HP23
Display X No effect on the HC2 probe
Automatic RH The sensor status can be read with HW4 but not with the HP23
sensor test and X .
. display
compensation
The HC2 probe can be configured to trigger an alarm when the RH
sensor test returns a bad result. Independently of the RH sensor
test, the HC2 probe will trigger an alarm in the event of a major
failure of either the RH or temperature sensor (shorted or open
sensor).
Sensor al_arm and X Additionally, the HC2 probe can be configured to generate a fixed
sensor failure mode 5 ;
value for humidity and temperature whenever a sensor alarm is
triggered.
The HP23 will display an alarm when the RH sensor test returns a
bad result and will also do so for any shorted or open sensor.
Data logging by the HP23 can be started or stopped from the HP23
keypad. All log settings can be changed from the HP23 keypad.
Data logging X X
Data recording by the HC2 probe itself cannot be started or stopped
with the HP23 keypad
Data capture X Current data can be manually captured from the HP23 keypad to
P one of the 8 data bins (250 values per data bin)
The AW Mode can be enabled, disabled and configured from the
Aw Measurement X

HP23 keypad.
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2.2 Detecting the HP23 indicator with HW4

Use a USB cable (mini-USB connector on the side of the HP23) to connect the service connector of the
HP23 indicator to the HW4 PC. Unless already installed, you should install the ROTRONIC USB driver on
the PC before running HW4. Proceed as indicated in document E-IN-HW4v3-Main.

File Devices and Groups Wiew  Settingsar  After detection by HW4, the HP23 appears as an icon in
- : the left pane of the HW4 main screen.
@ §F 5 1 — x

B Hrzs

File Devicesand Groups  View —
oy @ f Bk = x

Click on the + sign to the left of the HP23 icon to display
the HP23 Device Manager module, the Record Data
€3 Device Manager module as well as two probe icons (one for each of the

HP23 inputs).
I Record Data puts)
[+ mm= Probe 1

[+ = Probe 2

File  Devices and Groups  Wiew  Settings am

@A § Ak o

- = Click on the + sign to the left of a probe icon to display a
HP23 list of the available functional modules for the probe.

@ Device Manager

IH FRecord Data

(=} mm= Probe 1

@ Device Manager
IH Record Data

—= Probe Adjuztment

== Probe 2
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3 DEVICE MANAGER

Device Manager is used to configure the HP23.

File  Devices and Groups  Yiew  Setkings ar

S @ § Bk = x

@ Device Manager
H Record Data
a= Probe 1
e Probe 2

To select the Device Manager for the HP23, click on it
= with the left mouse button. HW4 opens the Device
= E HFZ3 Manager form.

Device Manager automatically interrogates the HP23 and downloads its current configuration.

File  Tools  Help

Device Manager HP23 ]

Ok,

: Device Infarmation

- Gettings Device Information

o Unit Spstem

o Input 1 ;

g 2 Device Type HP23

- Dizplay Firmware Release V2.0a

; "EW Mo . Hardware “ersion 5

- Jser Calculations
Serial Mumber 2705201001
RPC 10082252800
Last Configuration 6/12/2010 4:38 PM 00000001
Firrrware Update 1/1/2000 12:00 AM 00000000
R5-485 Address 1] Change
Yi'rite Protection Off Change
ok ] [ Cancel

The different sub-forms that are available within the Device Manager form are listed in a tree located on the
left pane of the form. To select a sub-form, click on it with the left mouse button.
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3.1 Device Manager Menu Bar

The Device Manager menu bar is located at the top of the form.
File

The file menu is used to save to the PC, or to retrieve from the PC, the configuration settings of the HP23.
The settings are saved in an XML file with the extension DAT. Saving the configuration settings to a file is
useful for several reasons:

- provides a backup when the device configuration has been changed in error

- provides a means of quickly configuring a replacement device in the exact same manner as the
original device

- provides a means of quickly configuring a number of identical devices

Open: opens the device configuration folder specified in HW4 Global Settings - File Locations Tab - and
displays all available probe and device configuration files (extension DAT). Select the appropriate file and
click on Open in the explorer form. The contents of the configuration file are loaded to the Device Manager
form. Review the contents of the Device Manager sub-forms. Click on the Device Manager OK button to
write the configuration settings to the device or click on the Cancel button to leave the device unchanged.

Laok in: | 53 58 ¥ Q% -

HC2-SN2.DAT
. HygroClip DLDAT
~ = Hygroclipalarm.DaT
Bdg Cifnii?; HygroFlex.DaT
HygroLoghT.DAT

@ HygroStat.DaT

Desktop

=/

My Documents

b ‘C
 Lomputer File name: | w
B Files of type:

Device configuration files [*.DAT) w

Save As: saves the current configuration to an XML file with the extension DAT) in the device configuration
folder specified in HW4 Global Settings - File Locations Tab. If so desired, any directory and any file type
may be specified.
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Save As @
Save jn; |l'f)SYS V| o+ | T = E-
N = CMF-HC2-SM1-2, 51l
L@ = CMF-HC2-SML. xrr
: B]HC2-5M2-20080112,401
oot Ghco-anz paT
HC2-SMZ,PRG
= HygroClip DLOAT
= HygroClipalarm.DAT
Desktop HygroFlex.DAT
HygroLogT.DAT
- [e=l HygroLoghT PRG
_,J HygroStatDAT
My Documents
My‘C.omputer
File name: |HF5-CNF-001 | [ save |
[ = | Save as bype: | w | ’ Cancel ]

Exit: exits Device Manager
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Tools

Firmware Update: This tool is used to update the firmware of the HP23 after downloading a new firmware
file from the ROTRONIC website to your PC. Firmware files are given a name that shows both to which
device the file applies and the version number of the firmware. All firmware files have the extension HEX.
The ROTRONIC website will publish firmware updates as required.

The tool opens a form that allows you to specify the folder where the firmware update file is located and to
select the file. Click on OPEN to start the update process.

Laak jn: |_)Firmware v| ) tr s [~
CHold

| |[®]HF32_v1.2.hex
MyFecent | |[®]HF32s 1.2 hex
Documents |2 HF33_41.2,hex
|[®]HF33s_v1.2.hex
|[®]HF34_v1.2.hex
2] HF42_¥1.2.hex
] HF43_¥1.2.hex
] HF45_v1.2.hex
] HF53_v1.0-1.hex
|2 HFS5_Y1.0-1,hex
[=]HPz1_v1.2.hex
[ElHPz2_v1.0-1.hex

B HygroClip 2_%1.2, hex

&

=)

Desktop

\$

My Documents

il e [HP22_/1.0-1 hex v [ Open |

by Metwark, Files of bype: |*_HE>< v| ’ Cancel ]

IMPORTANT: the HP23 must be powered during the entire process. Loss of power when the transmitter is
being updated may have unexpected results and prevent future operation of the HP23.

Generate Protocol: generates a Device Configuration Protocol. This text file is automatically saved in the

folder specified in HW4 Global Settings - File Locations Tab. If so desired, any directory and any file type
may be specified. This action is not recorded in the User Event file.

Help:
HW4 Help: Opens HW4 Help

About HW4: Displays the version number and ID number of HW4

© 2010; Rotronic AG E-M-HW4v3-F2-012_10
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3.2 Device Information

File  Tools  Help

Ok

Dewice Infarmation
- Seftings Device Information
o Unit Spztern
“nput 1 : 5
e Device Type HP23 :
- Dizplay Firmware Release V2.0a
i EWMDdE : Hardware “Wersion 5
zer Caloulations
Serial Mumber 2705201001
RPC 10082252800
Last Configuration 6/12/2010 4:38 PM 00000001
Firmware Update 1/1/2000 12:00 AM 00000000
R3-485 Address 1] Change
Yi'rite Protection Off Change
0k ] [ Cancel

RS485 Address: click on the underlined blue link to change the transmitter address to be used in
conjunction with an RS-485 network (multi-drop). Each network address should be unique and within the
values of 1 to 64. Note: the default factory RS-485 address is 0. Click on the Device Manager OK button to
write the new address to the transmitter.

o0 Write Protection: This function is used to prevent unauthorized access to critical functions such as
configuration changes, humidity and temperature adjustment, etc Click on the underlined link next to
Device Protection. HW4 opens the following form where a password can be entered (maximum 8

characters):

Enahle Write Protection

Enter paszward [max 8 char.]

Cancel

Click on the Device Manager OK button to write the new protection settings to the HP23.

FORGOT THE PASSWORD? - Power down the HP23. After powering up the HP23, you have about one
minute to use the default password !resume! (include the exclamation marks). After one minute the default
password is no longer accepted.
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3.3 Settings

File  Tools  Help

Device [nformation

Settings Settings
Unit System ¥
|hput 1 2O (4 N e
Input 2 Device Marme |HP23-Ay
DIS|J|EI_|,J e ———————— = = . =
2 Mode Fixed Pressure Walue !_'I_EI13.2§ _|hPa
User Calculations Data Refresh Rate 13 vl
Battery Type Siandard _t
Date and Time 61272010 4:38 Ph

et to PC Date and Time

Ok ] [ Cancel

Ok

Device Name: As far as possible use a unique device name (maximum 12 characters)

Fixed Pressure Val.: enter here the fixed numerical value to be used for barometric pressure when
calculating the following parameters: Wet bulb temperature, Enthalpy, Specific humidity and Mixing ratio by
weight. This numerical value should correspond to the typical barometric pressure at your elevation (or in
your process) and should be consistent with the unit system that is being used. Note: when one of the
probe inputs is set for an analog pressure probe, the probe measurements are used instead of the fixed
pressure value.

Data Refresh Rate: the user can select a time interval for refreshing the data on the LC display. When the
interval is 10 s or more, the probes are not powered in between display refreshes so as to conserve battery
power.

12 .r; Notes:

o When the HP23 is recording data, the probes are powered as required by
10; the log interval, regardless of the value of the display refresh interval.
1"“”_ o The HygroClip 2 probe will not test the RH sensor when the refresh interval
1 0rmin for the LC display is set above 1 sec.

Battery Type: select standard or rechargeable. Rechargeable enables the HP23 battery charge
function. Be sure not to select Rechargeable when using a standard battery. Attempting to recharge a
standard battery is dangerous and could damage the HP23.

Set to PC Date and Time: click on this link to immediately set the clock of the HP23 to the date and
time of the PC. Do not use this link when the HP23 is recording data.
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3.4 Unit System

Device Manager HP23
File  Tools  Help

- Device Infarmation

- Settings Unit System

I L nit Spstem

el hput 1 Lt

; urnidit

S lmput 2 ¥

- Display Temperaturs

ot Mode

‘o Jger Calculations Rizesyin
Enthalpy

Density by Yolume
Density by Weight

Time Format
Date Format

Date Separatar

Iﬁ—I

Mletric
English

ni

<

|hF'a

<

| kJkg

|g.l'm3
wa v

24H v

hARADD Y Y w
]

<

<

Ok

| ok, ||  cancal

Humidity: enter here the letters to be used after the “%” symbol used for relative humidity

Temperature and other parameters: Left click on the arrow to the right of the text box and select the

engineering unit.

Click with the mouse on the blue links labeled Metric or English to globally set the unit system for all

parameters.

Time Format, Date Format, Date Separator: these settings can be changed to match your preferences

practices

Note: For both HW4 and the local HP23 display, the unit system selected for the HP23 overrides the unit

system selected for the probe.
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3.5 Inputl/Input?2

Type of Probe: any of the HP23 two probe inputs can be set to accept either a digital HygroClip 2 probe or
an analog probe. Click on the blue link on the top right corner of the form to change the type of probe.

3.5.1 Digital HygroClip 2 Probe

Device Manager HPZ3

File  Tools  Help

Device Information

- Seftings Input 1 (Digital)

o Unit Spgtern .

; Serial Mumber 0074977428 W1.5-1
o Input 2 Description Probe 1

o Digplay ;

o Modie Calculation |Frosst Pairt (Fp)

i Jger Calculations

Lo-Alarm Hi-Alarm Hyst

[] Humidity 0 | oo | |05

] Temperature 0 | [100 | |os e
[ Caleulation 0 | [100 | |05 e
[[] Generate Fixed Humidity “alue |§§ |

[[] Generate Fixed Temperature Yalue |53 |

[[] Generate fixed values when probe connection is lost

[ ok ] [ Cancel

QK

Description: enter here a description for the probe input (maximum 12 characters). This text can be
displayed in the HW4 current Values tab.

Calculation: Left click on the arrow to the right of the text box and select from one of the available
psychrometric calculations:

| Frost Point ¢Fp) v
Mo calculation
Doy Pairt (Dp) Dew Point: calculates the dew point above and below freezing

Notes:

et Bl Tempearature (Tw) Frost Point: calculates the frost point below freezing and the dew
Erthalpy (H) point above freezing

Wapar Concerntration (v

Specific Humidity (G)

Mixing Ratio by Weight (R)

Wapor Concerntration st Saturation (Dvs)

“apor Partial Prezsure (E)

Yapor Saturation Pressure (Ew)
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Lo-Alarm, Hi-Alarm, Hysteresis: Alarm conditions can be defined for humidity, temperature and the
calculated parameter. Values that are below the low alarm value or above the high alarm value will trigger
an alarm. The value specified for the alarm function hysteresis is used for both the low and the high alarm.

All versions of HW4 show an out-of-limits value alarm by using red characters on the monitor screen. In
addition, HW4 Professional can be configured (HW4 global settings - Alarm settings tab) to display an alarm
table and generate a report whenever an out-of-limits condition occurs.

Note: in general, enable this alarm function only at the level of the HP23 and not at the level of the probe

Generate Humidity Fixed Value / Generate Temperature Fixed Value: place a check mark in these boxes
to make the HP23 generate fixed humidity and temperature values instead of reporting the actual
measurements.

The fixed values must be within the following limits: -999.99 and 9999.99

Whenever the humidity and/or temperature signal is set to a fixed value, this is reported on the HW4 main
screen (current Values tab) as shown below. In addition, an entry is made in the Alarm Table (HW4
Professional)

File  Devices and Groups  Miew  Settings and Tools  Help

i E F A IME —

CurrentValues | Online Buffer Logto PC | View

Device Manager - . :

? Ha:::lrd Data ? Humidity Simulator fTemperature Simulator

4 == Probe 1 ! # Input Name Value
' | 35.00%K
[+ === Probe 2 5 e S wRIT

4 Alarm Table

File ‘igw Options

alofe]t ¥ ke

Start Time Device name Alarm Description
! {0 4/9/2009 250 PM HF23 Temperature Fixed W alue
! 4/9/2003 250 PM HP23 Humidity Fixed ¥ alue
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Simulator Action table

HP23 simulation Probe simulation HW4 and local HP23 display
enabled enabled or disabled HP23 simulated values
disabled enabled Probe simulated values
disabled disabled Actual measurement values

Generate fixed values when probe connection is lost: place a check mark in this box to make the HP23
generate fixed humidity and temperature values whenever communication with the probe is lost. The fixed
values are the same as specified under Generate Humidity Fixed Value / Generate Temperature Fixed

Value.

HygroClip 2 Probe Alarms — Action Table

HW4 and the HP23 monitor the alarms generated at the level of the HygroClip 2 probe as indicated in the

table below:
HC2 probe alarm HWA4 HP23
Out-of-limit value Not monitored Not monitored
- Warning appears on monitor screen - Sensor Alarm appears at the bottom of
- Entry in alarm table local display
RH sensor test - When the probe sensor failure mode is - When probe sensor failure mode is
result = Bad enabled, the parameter corresponding enabled, the parameter corresponding

to the faulty sensor takes fixed value as
per the HC2 probe settings

to the faulty sensor takes fixed value
as per the HC2 probe settings.

- Warning appears on monitor screen

- Entry in alarm table

- When the probe sensor failure mode is
enabled, the parameter corresponding
to the faulty sensor takes a fixed value
as per the HC2 probe settings.

Major sensor
failure (shorted or
open sensor)

- Sensor Alarm appears at the bottom of
local display

- When the probe sensor failure mode is
enabled, the parameter corresponding
to the faulty sensor takes a fixed value
as per the HC2 probe settings.
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3.5.2 Analog probe and analog pressure probe (single channel)

Note: Do not forget to configure HW4 to display analog input signals (HW4 Main Menu Bar > Settings and
Tools > Column Headers > Analog Input). Do not use this setting when the HP23 is in the Aw Mode

Device Manager HP23 @

File  Tools  Help

Device [nformation

Settings Input 1 (Analog)

it Spstemn

[rput 1 T =

Input 2 Description I[F'rnhe 1

Dizplay - = — W

Aw Mode T 1 PP ——

zer Calculations Voltage range I.D &= !EDD __lr'n‘v"
heasuring range a |- |10 |
Unit of Measurerment E_XYZ = '

Lo-Alarm  Hi-Alarm Hysteresis

[ Alarm B e [Wes |
[ Use fixed value |35 B

[] Generate fixed values when probe connection is lost
[] Pressure Probe

[ ok ] [ Cancel

Ok,

Description: enter here a description for the probe input (maximum 12 characters). This text can be
displayed in the HW4 current Values tab.

Voltage range: enter here the minimum and maximum of the probe output signal range. The HP23 accepts
probes with a voltage signal within the limits of 0 to 3.3 VDC

Measuring range: enter here the minimum and maximum of the probe measuring range. The values must
be with the following limits: -999.99 and 9999.99

Unit of Measurement: enter here the unit of measurement that will be displayed by both HW4 and by the
HP23 (maximum 3 characters). When the pressure probe option is selected, HW4 automatically enters in
this field, the barometric pressure unit selected in the Units System form.

Lo-Alarm, Hi-Alarm, Hysteresis: Alarm conditions can be defined for the parameter measured by the
probe. Values that are below the low alarm value or above the high alarm value will trigger an alarm. The
value specified for the alarm function hysteresis is used for both the low and the high alarm.

All versions of HW4 show an out-of-limits value alarm by using red characters on the monitor screen. In
addition, HW4 Professional can be configured (HW4 global settings - Alarm settings tab) to display an alarm
table and generate a report whenever an out-of-limits condition occurs.

Generate Fixed Value: place a check mark in this box to make the HP23 generate a fixed value instead of
reporting the actual measurement.

The fixed value must be within the following limits: -999.99 and 9999.99
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Whenever the humidity and/or temperature signal is set to a fixed value, this is reported on the HW4 main
screen (current Values tab) as shown below. In addition, an entry is made in the Alarm Table (HW4
Professional)

Generate fixed values when probe connection is lost: place a check mark in this box to make the HP23
generate a fixed value whenever communication with the probe is lost. The fixed value is the same as
specified under Generate Fixed Value.

Pressure Probe: select this option when the analog probe measures barometric pressure. When this option
is selected, the pressure measured by the probe is used as an input for a number of psychrometric
calculations that may be performed on the other probe input.

3.6 Display
Device Manager HP23 @
File  Tools  Help
- Device Information . "
Settings Display wym
Urit System ;i /
Impuat 1 Language English Load Lan File & '/
|nput 2
L Backlight Mode [onkeyPress ™) v
A Mode g I ‘)"= — ——
User Calculations Display Mode iRH+T + Date/Time v /
Resalution [2Decimats v'
Contrast J Apply
Trend Indicatars Stability [X/min] [ 0.0z
Shaow Trend Indicatar
Allow Menu Access
Enahle DPhe/UCale
Q. ] [ Cancel
04

Load Language File: click on this link to change the language of the HP23 internal menu by writing to the
HP23 the contents of a language file present on your PC

Backlight Operation: click on the arrow to the right of the box and select from Always off, Always on or On
Key Press (this last choice applies only to instruments that have the optional display with backlighting)

Display Mode: select from the following options: RH + T + Date / Time, RH + T + Calculation or large
display characters (RH or T or Calculation selected on the HP23 with the ENTER key) and date / time

Resolution: select from the following options one or two decimals

Contrast: use the slider to adjust the contrast of the LC display and click on the Update link to change the
contrast. Click on the Update link to write the new contrast setting to the HP23.
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Trend Indicator Stability: enter in this text field the stability criteria used by the trend indicators. A value of
0.01 means that when the rate of signal change is less than 0.01 units per minute, the signal is shown as
stable.

Show Trend Indicator: check this box to enable the trend indicators on the optional local display. Trend
indication within the HW4 Current Values tab is a Global Setting of HW4 (HW4 Main Menu > Settings and
Tools > View tab)

Allow Menu Access: put a check mark in this box to prevent access to the internal menu of the HP23 from
the keypad.

Enable DPbe/UCalc: check this box to enable the HP23 to display the difference between the two probe
inputs (measured and calculated parameters : probe 1 less probe 2). Displaying the difference between the
two probe inputs can be selected from the keypad with the UP or DOWN arrow. When User Calculations is
enabled, selecting the fictitious third probe displays the user defined calculations and the difference between
the two probes is no longer available.

3.7 Aw Mode
File  Tools  Help
Device [nfarmation
Settings Aw Mode
Unit System "
[rput 1 Enable Water Activity Mode o
Input 2 Enable Beeper Test
'SD'P Save Results to Data Bin
Cssraiculolions @ AW-Quick Made Settings
el Tirne [min] [3
Temperature Stability [*C/min] 0.0
) AWWE Mode Settings
Hurnidity Stability [2wermin] [aooot
Temperature Stability [*C/min] 0.0
0k ] [ Cancel
oK

Enable Water Activity Mode: check this box to enable the Aw mode. In this mode, the HP23 automatically
displays humidity as aw (1.00 a, = 100 %RH)

Enable Beeper: when this box is checked, the HP23 gives an acoustic signal during 5 seconds at the end of
each Aw measurement

Save Results to Data Bin: when this box is checked, the HP23 automatically saves the water activity value,
the temperature value as well as the date and time at the end of each measurement. Probe 1 is always
saved to data bin 1 and probe 2 to data bin 2 (up to 250 records per probe).

© 2010; Rotronic AG E-M-HW4v3-F2-012_10




Rotronic AG
E'M'HW4V3'F2'012_10 Bassersdorf, Switzerland
Document code Unit
HW4 software v.3: Instruction Manual
Device Manager and Data Recording Document Type
HP23 Humidity Temperature Indicator

Page 20 of 27

Document title

AwQuick Option: this option accelerates the measurement of water activity. With most products the time
required to measure water activity is reduced to typically 5 minutes. The measurement starts simultaneously
for both probe inputs and is ended automatically.

Settings:

o Dwell Time (minutes): initial time during which the AwQuick algorithm does not run

o Temperature Stability ( “C/ min): defines the temperature stability requirement during the

measurement
AwE Option: Conventional water activity measurement, the HP23 waits for full equilibration of the
measured product. The measurement starts simultaneously for both probe inputs. The HP23 automatically
detects full equilibrium conditions and ends the measurement at that time.
Settings:
0 Humidity Stability (aw / min): the measurement ends when this requirement is met.

o0 Temperature Stability ( °C/ min): the measurement carries on as long as this stability
requirement is not met

3.8 User calculations

Device Manager HP23 @

File  Tools  Help

Device [nformation

- Gettings User Calculations

it Spstemn "

L lnplE T [#] Enahble L

; ln.DUtz Description |Cu5tom Calc

Dizplay e s S

C B M ode Calculation 1 il -

B U zer Calculations iTE'l - Al [
Lnit . |__C_’ | Check Fomuls
Prefix IF1 |

Calculation 2
[HUT+HU 22

LInit %RH | Check Formiula
Prefix lFE |

ok ] [ Cancel

Ok,

The HP23 can perform and display up to two user defined calculations. Click on the box labeled “Enable” to
turn on this function. A check mark appears.
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Rules and Syntax

e Description: text with a maximum of 12 characters maximum. This text appears at the bottom of the HP23
display.

e Formulas: formulas can be made of up to 64 characters and can contain the variables, constants and
operators defined below as well as up to 10 levels of nested parenthesis.

e Variables: variables are measured or calculated values from input 1 or input 2

o] Temperature Input 1 or 2 ‘TE1, TE2

o] Humidity Input1 or 2: :HU1, HU2

o Calculated Parameter Input 1 or 2 :CA1, CA2

o Water Activity Input1 or 2 :HQ1, HQ2 (water
Activity mode only)

o] Temperature Input 1 or 2 :TQ1, TQ2 (water Activity
mode only)

e Operators and operator symbols:

o] Addition T+

o] Subtraction -

o Multiplication i

o] Division i

Comparisons and conditional branching are not supported.

e Examples
o HU1 —HU2: humidity input 1 less humidity input 2

o (TE1+ TE2)/2: average temperature input 1 and input 2
o TE2 - CA2: difference between the temperature and dew point input 2 (assuming DP is calculated)

e A prefix (maximum 2 characters) as well as an engineering unit (maximum 4 characters) can be
associated with each calculation. Both the prefix and engineering unit are shown on the HP23 display.
Notes:
0 Inorder to enter °C or °F in the unit field, press the ALT key and type 096 (not 248), release the

ALT key and type C or F.
o Click on the blue link labeled “Check Formula” to verify the syntax
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4 DATA RECORDING

Data Recording is used to configure the data recording functions of the HP23, to start and stop data logging
by the HP23 and to download the recorded data to the HW4 PC.

F 'I'!_ To select Data Recording, click on it with the left mouse

File Devices and Groups  Wiew  Settings an button. HW4 opens the Data Recording form.

SN[@ § Bk x
= B HPz:
@ Device Manager
H Data Becording
= Frobe 1

&= Probe 2

4.1 Datalogging — Settings

Dakta Recul:aing E|
File  Settings and Tools  Help.
[=)- Data Logging
; Settings Data Logging
i Data Download "
= Data Capture g
Fenarme Data Bins Status Not Recording Start Logging
[ ata Bin Contentz Made |Star‘[—StDp v|
Log Interval 00:00:10 2| [hh:mrmn:ss]
Frobe 1
Probe 2
Configuration Date 4/17/2009 11:37 PM 00000002

This form is used to select the following:
o Recording mode:

Start-Stop: ends the recording when the memory is full
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Loop: when the memory is full, keep recording and dump the oldest data record
o Log interval: 5 seconds to 1 hour

o Probeto berecorded: Probe 1, Probe 2 or both

Note: when recording two probes simultaneously, the memory of the HP23 is shared equally between the
two probes meaning that the recording capacity per probe is half of what it would be when just one probe is
being recorded.

4.2 Datalogging — Data Download

This form is used to download to the PC the HP23 log file. The file can be downloaded even when data is
still being recorded.

Data Recording ]

File  Settings and Tools  Help

f =) Data Logging
Settings Data Download
D ata Download W
=) Data Capture g
Rename Data Bins
Data Bin Contents Status Not Recording
File Size 40,002Byte  (100%)
Data Samples 6666
Remaining Time 45s
Frogress [ ]

Start Download

Cloze

Click on the blue link labeled “Start Download” to download the data logged by the HP23

4.3 Adding a calculated parameter to the log file

HW4 View Data can be used to add a calculated parameter such as dew point to a log file comprised of
relative humidity and temperature records. The parameter is calculated for each data record based on the
relative humidity and temperature values.

HW4 View Data can also be used to replace the calculated parameter in a log file with a different one.
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HW4 View Data opens automatically after reading data from the HP23 indicator. Files that have already
been downloaded can be opened from the HW4 main menu bar by selecting File > Open.

To access the “Add / Change calculated parameter” function, click on Tools in the HW4 View Data menu
bar and select “Add / Change calculated parameter”. This opens the following form:

Select Calculated Parameter X

{(#) Diew point

) Frost point

1 wet-bulb temperature

) Enthalpy

() Wapor concentration [maist]

(3 Specific huridity [maoist]

(3 Mixing ratio by W [diy

() 5 aturation wapor concentration
) W apor partial pressure

{3 Wapor saturation pressure

Fixed Prezsure 1013.25 hPa

k. l [ Cancel

Use the form shown on the left to select one of
the available calculated parameters.

NOTE: some parameters such as Enthalpy,
Mixing Ratio etc. require barometric pressure as
a calculation input. Be sure to enter the correct
pressure value in the form.

Click on the OK button to add the selected calculated parameter or change the existing calculated

parameter.

4.4 Data Capture — Rename Data Bins

The current humidity and temperature data read by a HygroClip 2 probe can be saved in any of 8 data bins,

each holding up to 250 records each.

This form is used to replace the generic name of the data bins (Bin 1 to Bin 8) with user specified names.
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Data Recording X

File  Settings and Tools  Help.

=) Data Logging
- Gettings Rename Data Bins :
; D ata Download r&
=) Data Capture
S Data Bin 1 |Lahnramry |
Data Bin 2 |Warehuuse |
Data Bin 3 \Bin 3 |
Data Bin 4 \Bin 4 |
Data Bin 5 |Bin 5 |
Data Bin B Bin & |
Data Bin 7 \Bin 7 |
Data Bin 8 \Bin 8 |
Apply

Cloze

After renaming one or several data bins with a user specific name, click on the blue link labeled “Apply”.
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4.5 Data Capture — Data Bin Contents

This form is used either to download the contents of a data bin to a file on the PC or to erase the contents of
the data bin.

Data Recording ]

File  Settings and Tools  Help

(=l D'ata Logging
Settings Data Bin Contents
Data Download u,
=) Data Capture . ]
Rename D ata Bins Bin Mame Data Samples

[ ata Bin Contents

Laborataory " Download Erase
YWarehouse 5 Download Erase
Bin 3 1 Download Erase
Bin 4 0 Download Erase
Bin& 0 Download Erase
Bin & 0 Download Erase
Bin 7 0 Download Erase
Bin & 0 Download Erase

Cloze

o To download the contents of a Data Bin to the PC, click on the blue link labeled “Download”.

o To erase the contents of a Data Bin, click on the blue link labeled “Erase”.
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5

PROBES

NOTE: we recommend using the same humidity symbol and the same temperature unit (°C or °F) for both
the probe and HP23.

File  Devices and Groups

PR E A E

View  Settings an

@ Device Manager

HH Becord Data
[=}- = Probe 1

@ Device Manager
H Record Data

—= Probe Adjustment

== Probe 2

Click on the + sign to the left of a probe icon to display a
list of the available functional modules for the probe.

To select a function module, click on it with the left mouse
button.

0 The Device Manager module is used to configure the HygroClip 2 probe connected to the HP23
indicator and is separately described in the HW4 manual E-M-HW4v3-F2-001

o The Record Data module is common to all probes and instruments based on the AirChip 3000
technology and is separately described in the HW4 manual E-M-HW4v3-DR-001

0 The Probe Adjustment module is used calibrate and adjust the probe humidity and temperature signals.
This module is common to all probes and instruments based on the AirChip 3000 technology and is
separately described in the HW4 manual E-M-HW4v3-A2-001

o HW4 functions that are not device dependent are covered in the HW4 manual E-IN-HW4v3-Main.

6 DOCUMENT RELEASES
Release |Software Ver. |Date Notes
_10 3.0.0 June 18, 2010 Original release
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